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RHAON Installation and Troubleshooting  Guide

This guide will take you through the process of firing up your RHAON equipped system  for the first time and help you find and resolve any 
startup problems. 

Most startup problems are either setup or network problems and not Iconyx or RHAON problems.  Your RHAON equipped  loudspeakers 
were carefully tested before they left our factory and are rarely the source of a  problem. Nevertheless, it’s always wise to check out each 
loudspeaker before it’s actually installed. It’s a lot easier to check out a problem in your shop than it is when it’s installed 40 feet in the air.
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A few Words about Networking
RHAON connects your computer and loudspeakers together over an Ethernet network using standard Ethernet hardware and CobraNet 
technology. Ethernet is a frame-based computer networking system that communicates by sending uniquely addressed packets of informa-
tion from a source to a destination. Devices on the network (Loudspeakers, switches, sources, etc.) are addressed by a Machine Access 
Code (MAC address) that is burned into them by the manufacturer of the device.  Devices on an Ethernet network also need an Internet 
Protocol address (IP address). In RHAON systems, IP address assignments are handled by RHAON 

CobraNet is a protocol and associated firmware and hardware that allows digital audio and control information to be sent over an Ethernet 
network as Ethernet packets. Note that the distribution of Digital Audio and the control and supervision of the associated RHAON equipped 
loudspeakers are two separate functions. 

For more information on Networking, refer to pages 8 & 9 of this document or to the User’s manual for your loudspeakers.

Computer Setup

CobraNet requires a WIRED connection to the network.   Wi-Fi doesn’t have sufficient bandwidth to handle CobraNet.

Your RHAON computer must have a NIC (Network Interface Card) and it must be properly configured with a private IP address. 

If you are running Windows XP go to Start: Settings\Control Panel\Network Connections\Local Area Connection and click on Properties,  
Verify that the correct NIC card is selected, then select Internet Protocol (TCP/IP), click on Properties, Click on “Use the following IP Ad-
dress” and enter: IP address: 192.168.1.1 ; Subnet mask: 255.255.255.0; leave the other fields blank. 

If you are running Windows 7 or Vista, go to Start: Settings\Control Panel\All Control Panel Items\Network and Sharing Center\Local Area 
Connection, click on Properties. Verify that the correct NIC card is selected, then select Internet Protocol Version 4, click on Properties, click 
“Use the following IP Address” and enter: IP address: 192.168.1.1 ; Subnet mask: 255.255.255.0; leav e the other fields blank. 
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IP Address Setup.

The next step is to check your computer for third party virus checker or firewall software. CobraNet uses “packets” to communicate and many 
versions of Zone Alarm, Norton Internet Security and McAfee will block CobraNet packets unless they are correctly configured. We recom-
mend disabling them. The Windows firewall can remain on. 

We also recommend that you set your computers Hibernation / Sleep settings to “Never”. If your computer goes to sleep while connected 
to the network, it may cause some of the CobraNet components to malfunction and your RHAON program start to do weird things. Refer to 
page 14  for details.

Each device on the RHAON/CobraNet network 
must have a unique IP Address in order to commu-
nicate over the network. RHAON will assign these 
automatically, but you need to give RHAON a range 
of acceptable numbers. 

Open RHAON and  go to Options > Preferences > 
General and enter a range of IP addresses into the 
IP Addressing fields. We suggest using 192.168.1.2 
and 192.168.1.100. 

Note that other private IP Ranges can be used. 
For detailed information, please refer to the User 
Manual that came with your Renkus-Heinz loud-
speaker.. If you can’t find it, open the RHAON drop 
down Help file, select RHAON Manuals and then 
choose the appropriate one. The manuals can also 
be downloaded from ftp.renkus-heinz.com/Software/
RHAON.

Before leaving this window, you also need to check 
the Adapter listing to make sure the correct NIC is 
selected. Hint - it should be the one you configured 
under Computer Setup. Use the drop down arrow to 
view the choices.

Network Manager

Since most installation and startup problems are network problems and not loudspeaker or RHAON problems, RHAON includes a Network 
Manager that allows you to check the integrity of the Ethernet network before you actually link to the loudspeakers. It is accessed from 
RHAON and identifies network problems for you before you waste a lot of time checking out the loudspeakers. 
 
To activate the RHAON Network Manager  open RHAON and select Network Manager from the File pull down menu.

The Network Manager will scan the Ethernet network, list all the CobraNet devices it finds on the network and identify them by name and by 
their MAC and IP numbers. Please refer to the graphic shown on the next page. It also checks for communication errors (dropped packets). 
Remember, RHAON communicates over the Ethernet network by  packets. Any errors detected are counted and listed in the Error column 
along with a code number identifying the type of error last observed. 

In use, the error count will continue to increase as the Network Manager continues to scan the network for errors. The Age column shows 
in milliseconds how long it has been since the device was checked by the Network Manager. It is normal for the Age numbers to fluctuate 
rapidly.
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Network Manager (cont)

In the example shown below the ICL-FR Left array obviously has a problem while two other devices are showing an occasional glitch. All three 
need to be checked out and the problems corrected before proceeding.

RHAON also includes a reference guide for the Error codes used by  the Network Manager. It is accessed from the RHAON Help pull down 
menu.

The Startup IP column  will show a device’s Startup IP address, if a Startup IP has been 
assigned to it. 

IP addresses are normally assigned to the CobraNet devices by RHAON during startup and 
the assignment(s) will be lost if power is turned off or interrupted.  This usually doesn’t pres-
ent a problem since RHAON assigns new addresses as soon as power is restored.
 
In case this could present a problem RHAON allows Startup IP addresses to be assigned to 
individual devices. Startup IP addresses will not be lost in case power is interrupted. 

To assign a startup ID to a single device, double right click on one of the device’s listing 
to open the dialog box shown to the right. It allows you to assign a specific IP address (a 
startup IP) to that device.. You can also assign Startup IP addresses to all the devices at 
one time by clicking on the Command pull down menu and selecting Reset all IP Addresses 
as Startup. 
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Initial System Connections

Next return to RHAON and click on Scan Network to instruct RHAON to scan the network and list the results in the Network folder of the 
RHAON directory tree; see below.

Hint; if RHAON doesn’t find any devices but the Network Manager did, it’s likely that there is an error in the IP address setup. The 
Network Manager scans based on MAC (Machine Access Codes) while Scan Network looks for IP numbers.

The next step is to use your mouse to drag the loudspeaker listings from the Network Folder in the directory onto the desktop. This will link 
the actual loudspeaker and RHAON together and create an Icon for each loudspeaker. You will use these icons to communicate with the 
loudspeakers and to configure them. If you previously modelled this system in the virtual world icons representing each loudspeaker will 
already exist in the work space and you will need to drag the network listing for each loudspeaker onto the corresponding icon.
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Error Messages

Notice that the status bar on the loudspeaker icon will initially be yellow and read “Syncing”;  then it will turn green and read OK. 

At least it will turn green unless it picks up a loudspeaker problem. Then it will turn red and display an error message identifying the type of 
problem it found. Typical error messages are:

	 COLOR		  MESSAGE	 STATUS
	 Green		  OK		  Everything is OK
	 YELLOW		 Overload		 Amplifier is being over driven 
	 RED	 	 Offline	 	 Loudspeaker has lost power or been disconnected from the network
	 RED		  Driver Open	 One of the loudspeaker’s drivers has failed
	 RED	 	 Hot	 	 An amplifier’s over temperature circuitry is engaged
	 RED	 	 Limiting	 	 An amplifier is being overdriven or malfunctioning
	 RED	 	 Amp Fail	 	 An amplifier has failed

Double clicking on an icon which shows a malfunction will open one of its Properties Folders; selecting Supervise will open the Supervise 
window associated with that loudspeaker. The Supervise window for a two-way loudspeaker appears below.
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The actual configuration of the loudspeakers is beyond the scope of this installation guide. Please refer to the Users Manual if you need
assistance. 

IC16-R
OK



Ethernet Systems

A basic understanding of Local Area networks (LANs), Ethernet networks, packet addressing and CobraNet is critical for successful trouble 
shooting of RHAON systems.  

Ethernet Networks

The Ethernet protocol is a frame-based computer networking technology for local area networks (LANs).  This means it is a system for send-
ing uniquely addressed packets of information from a source to a destination, similar to how one sends a letter through the postal service.  
When you mail a letter to Aunt Gertrude across town, the letter doesn’t just go straight from your mailbox to your Aunt’s.  It goes to the post 
office, where it is sorted and  and sent along with Aunt Gertrude’s local mailman who then drops it off in her mailbox.  The same holds true for 
networks, only replace “post office” with “network switch”.

Switched networks are laid out in a “star” configuration, in that the topology has the switch at the center with links fanning out to all devices 
and/or other stars.  Typical transport media are CAT5 cable (up to 100 m or approximately 325 feet)) or optical fiber (up to more than 2 km).  
Communication is handled in a “Point-to-Point” fashion, in that each node communicates solely with the next node attached to it.  Using our 
previous example, the letter starts in your mailbox and is picked up by your mailman, who then transports your letter to the post office, where 
it is sorted and given to Gertrude’s mailman, who then drops it off in her mailbox.  How do the switches know where to send the packets?  By 
remembering, of course!  Just as the letter to Aunt Gertrude includes a “To” and “From” address, so does a packet.  The switch remembers 
which “From” addresses come from which port in order to speed up future traffic.

A typical “Star Wired” RHAON System

System that include both loudspeaker control and supervision and multi-channel digital audio distribution require a suitable Analog to Co-
braNet converter or a mixing console with a CobraNet output.
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Ethernet Systems (cont)

Ethernet Switches

Two of the main distinguishing characteristics between switches are speed and management.  The two main speed standards that comprise 
the majority of RHAON installations are 100Base-T (Fast Ethernet) and 1000Base-T (Gigabit Ethernet).  While RHAON device connections 
are Fast Ethernet, either speed may be used as higher speed switches are backwards compatible with those of lower speeds.  The advan-
tage to using Gigabit switches with a RHAON network is that while the individual connections are 100Base-T, the switching times (the time it 
takes between packet ingress and egress) are much shorter.  This becomes especially important from both a hop and total nodes standpoint 
as the size of a network grows. We recommend Gigabit switches for large networks.

 

Aside from speed, switches come in two flavors: Managed and Unmanaged.  An unmanaged switch is essentially a “dumb” black box that 
takes packets in and sends them where they need to go.  A managed switch, however, allows you much more control.  With a managed 
switch, one can designate subsets of ports as separate networks, control which types of packets are allowed in or out of certain ports, 
monitor current network traffic conditions, port status, etc.  For a great number of installations, an unmanaged switch will suffice.  However, 
for larger or more complex setups, a managed switch becomes critical, though a decent level of networking expertise is required for proper 
setup.

Packet Addressing

On a Local Area Network (LAN), packets are addressed by the Media Access Control (MAC) address of the network device.  MAC address-
es are “burnt-in” by the manufacturer of your network device (computer network card, RHAON loudspeaker, etc.) and are globally unique.  
This is like the VIN on your car.  No matter where you register your car, the VIN stays the same and is unlike that for any other vehicle 
worldwide.

In order to address different devices on different networks, Internet Protocol (IP) addresses were introduced.  They allow for easier routing 
for a vast array of interconnected networks.  Similar to this is the license plate on a car.  Rather than attempting to search for the car by 
going through the VINs for every car in the world, one could narrow things down by first selecting the country in which it was registered and 
then by license plate number within that country.  RHAON acts as the license plate authority, if a CobraNet device (RHAON speaker, mixer, 
etc.) doesn’t yet have a “license plate”, it asks RHAON for one and the software kindly obliges. It gives it an IP address.

Packets addressed by MAC address are known as “Ethernet packets”.  In addition to information about the source and destination and the 
payload, there is a marker for what type of Ethernet packet is being sent.  Packets that can be sent within or out of the LAN have one identifi-
er and CobraNet packets have another.  CobraNet packets don’t contain IP information in their payload, so CobraNet is limited to being used 
within LAN - only networks..  The structure of an IP packet is very similar, in that it contains - among other information - a source address, a 
destination address, and protocol type.  For RHAON, the protocol types of UDP and TCP are the ones in heavy use.  Building upon the UDP 
protocol is the Simple Network Management Protocol (SNMP), which is what RHAON uses to monitor or manipulate exposed variables (EQ, 
Bundle Assignments, etc.) on a RHAON loudspeaker or other CobraNet device.  At each stage in the process of handling a packet, the previ-
ous layer is left behind.  Once a payload type is determined, just that payload is handed off to the appropriate handler.

To better understand what takes place when RHAON tells a loudspeaker “Set Gain to -10dB”, think of Russian nested dolls.  Your computer 
will send out the whole doll, which contains an IP doll, which contains a UDP doll, which contains an SNMP doll, which contains the message 
“Set Gain to -10 dB”.  When a device sends out a piece of CobraNet audio, it sends out a whole doll, which contains a CobraNet doll, which 
contains the piece of audio.  

With CobraNet, since both devices have a ‘burnt-in’ MAC address, communication can happen right away.  For SNMP communication be-
tween the computer and RHAON loudspeaker to happen, both devices must have a valid IP address. In most home or office networks, there 
is a device called a ‘router’ that not only contains a network switch, but can also handle the assignment of IP addresses within its network 
through a protocol called DHCP.  CobraNet (and, by extension, RHAON) uses a different protocol for requesting / assigning IP addresses, 
but the end result is still the same.  Your router has a static IP address assigned to it, devices ask it for an IP, and the router obliges.  For 
this same reason you must assign a static IP address to your computer.
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Troubleshooting 

General Information

Most setup and installation problems are “network problems” and not loudspeaker or RHAON problems.

Your RHAON equipped loudspeaker or array was factory tested before it left our factory and barring shipping damage should be in perfect 
operating condition.

Nevertheless, if you have the chance it is always a good idea to run a quick check on each loudspeaker before taking it out to the job site 
and installing it. If you should run into a problem at the site, it’s good to know the problem is in the network or the system wiring and not in the 
loudspeakers.

To make this easy to do the Analog 1 input on RHAON loudspeakers and arrays is always connected, so it’s a simple matter to connect a line 
level analog signal to the device and check out its performance

In addition, Preset 10 on single arrays and Preset 20 on dual arrays are set to “Flat” and locked which sends an equal signal to all transduc-
ers for use in amplifier and transducer testing. Otherwise, it’s difficult to locate defective amplifiers and transducers as the digital beam steer-
ing reduces the drive to some transducers making it difficult to determine if a certain channel has failed or is operating satisfactorily. Because 
the transducers are located so close together using your fingertips to feel cone vibrations is usually a better way to check than listening.

The most common sources of system hum are the program source or an improper or poor ground on an audio signal line. Check the program 
source to make sure the hum isn’t originating there. Carefully check all the audio connections to make sure they are properly made.

Most noise problems are the result of improper grounding or of noise being induced into the audio signal line from adjacent noise sources, 
such as fluorescent lights, and close proximity of the audio signal lines to lines radiating noise. Carefully review all the audio connections and 
turn off all the lights and any other suspected noise sources.

Since RHAON relies on standard networking communications and hardware along with CobraNet, general networking and CobraNet trouble-
shooting documents can also be of assistance in solving problems. Don’t throw away any documentation related to the network switches or 
CobraNet source devices.

CobraNet Discovery

If you are familiar with CobraNet Discovery, you may also want to install and use it as a supplement to the RHAON Network Manager. Co-
braNet Discovery is a network management program similar to the RHAON Network Manager.  Both are invaluable in identifying and solving 
network problems. If you don’t have CobraNet Discovery, you can download it at no cost from our ftp site, hftp://ftp.renkus-heinz.com/Soft-
ware/CNDisco345.exe or you can install it from the RHAON CD you received with your loudspeaker.

Be aware, however , that you can not run RHAON and Cobranet Discovery v 4.0 or higher at the same time.

Cable Tester

Shorts, opens and mis-wiring are as much of a problem on networked systems as 
they are on any audio system and a good cable tester is indispensable. 

If you don’t have one, the Klein Tools LAN Scout Jr is a good basic tester that is reasonable 
priced. For example, you can pick one up at Home Depot for under 
$60.00. 
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Troubleshooting (cont)

Common Problems -- Split Pairs

One common Ethernet system wiring problem is “split pairs” since the Ethernet connector wiring is not intuitive. As you can see from the fol-
lowing graphics the second pair of wires connect to Pins 3 & 6, instead of to Pins 3 & 4 which would be more intuitive.

Split pair wiring causes dropped packets even if the offending cable is only a few feet long. 

Common Problems - No CobraNet Device Found

A common startup occurrence is the “No CobraNet Devices Found on the Network” error message that pops up when you first attempt to 
Scan the Network.

Fortunately, this problem is usually easier to solve than it appears to be at first glance. It’s usually something simple, such as an interfering 
software program running (see error message listing) or a  NIC setup problem.

CORRECT WIRING
Pins 1 &  2 = 1 pair
Pins 3 &  6 = 1 pair
Pins 4 &  5 = 1 pair
Pins 7 & 8 = 1 pair

INCORRECT WIRING (Split Pair) 
Pins 1 &  2 = 1 pair
Pins 3 &  4 = 1 pair
Pins 5 &  6 = 1 pair
Pins 7 &  8 = 1 pair
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Possible Cause / Solution

1. Are you trying to use a Wi-Fi connection? Switch to a wired con-
nection. You must use a wired Ethernet connection for RHAON as 
Wi-Fi doesn’t have sufficient bandwidth. 

2. Have you set up a private IP address on your Ethernet Network 
Interface Card (NIC)? Recheck your NIC settings.  Refer back to 
page 3 for assistance.

3. Did you select the correct NIC in RHAON? Recheck your selec-
tion.  In RHAON, go to Options > Preferences > General  and make 
sure the correct NIC is selected.— the same NIC  whose setting you 
checked in step two above. Refer back to page 4 for assistance.

4. Have you set RHAON to manage the correct IP Range? If not, 
In RHAON go to Options > Preferences > General and  set the IP 
Range to 192.168.1.2 to 192.168.1.100. Refer back to page 4 for 
assistance.

5. Have you tried the RHAON Network Manager to see if it can find 
the CobraNet devices? In RHAON select File > Network Manager. 
Wait for a minute or so; does the list populate with your RHAON/
CobraNet devices? If not, something is blocking CobraNet packets 
or you have a network problem.

6. Disable any third-party software firewalls and network security 
software. Versions of Zone Alarm, Norton Internet Security and McA-
fee Internet Security are known to block CobraNet packets and must 
be disabled to use RHAON. The Windows Firewall can remain on. 

7. If you have disabled any security software and still can’t see any 
CobraNet devices in the Network Manager, simplify your network 
by connecting directly to a single RHAON device using a known-
good cable, bypassing all installed network infrastructure including 
switches. Many lap tops have auto-switching NICs and do not 
require a crossover cable. Check the communication lights on the 
port, rapid flashing green indicates a connection. 

8. If you still cannot see any devices in Network Manager and you’ve 
double-checked all of the above, you may need to update the drivers 
for your NIC or try a different NIC.

RHAON can be somewhat sluggish, especially if digital audio is 
being distributed by CobraNet as CobraNet is given first priority, but 
if synchronizing and saving take more than 20-30 seconds, you may 
have a network problem.

Start the RHAON Network Manager and look at the error count for 
all devices. Any device that shows errors has a suspect network 
connection. Refer to the next Symptom for troubleshooting hints.

Problem or Symptom

RHAON says it can’t find any CobraNet devices on the network.

RHAON  devices are slow to synchronize and slow to save.

Problems & Solutions  - FAQ’s
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Possible Cause / Solution

1. Try a different port on the switch to see if this eliminates the er-
rors.

2. Qualify the cable. The cable must be able to qualify at 100 mbps

3. Check for split pairs. A split pair cable will drop packets even if the 
cable is only 2 meters long. 

4. Re-make the RJ45 connector. A marginal or corroded crimp will 
cause dropped packets.

5. Check the cable length. The Ethernet standard for unshielded 
twisted pair copper cables is a maximum 100 meters (330 feet). 
Copper cables longer than this will not support CobraNet streaming 
audio.

This indicates that this RHAON device is acting as the CobraNet 
Conductor and it is passing signal. Every CobraNet network has a 
“conductor” to which all the other devices are synchronized. The 
flashing amber LED indicates this device is the conductor. This is a 
normal condition.

This is a classic symptom of network problems. Go to the Network 
Manager and look at the error count for all devices. Any device that 
shows errors has a suspect network connection. Review the previ-
ous page for troubleshooting tips..

You are sending a signal to Analog 1, but some other input is 
selected in the Connect tab. As an aid to troubleshooting the 	
Analog 1 input will always pass audio, but if some other input is 
selected, Analog 2 for example, the signal to Analog 1 must exceed 
a threshold before it turns on. This is why you hear it gating. Select 
Analog 1 as the input and the gating will stop.

1. You have the Ethernet cable plugged into a slave unit. Either 
move the cable to the master unit or set the unit with the cable to 	
be the master. Check the DIP switches, there must be only one mas-
ter and the slaves must be individually identified as slave modules.

2. Did you connect the interconnect cables between the modules 
and screw down the connectors? If not, you must do this.
				  
3. Has the interconnect ribbon cable been accidently pinched be-
tween the cabinets? If so, it may be damaged and needs
replacement.

If the wink light is slowly flashing, you probably have the Ethernet 
cable plugged into a slave unit. See previous Symptom/Solution.

Try Restarting the unit by pressing the Restart button. Double click 
on its icon and press the Restart button when its properties window 
opens.		

Problem or Symptom

The Network Manager is showing errors on one or more
 devices

Both the green and amber LEDs on one of my device’s Ethernet 
port are flashing; on all of the other devices only the green LED 

is flashing.
 

I can communicate with my Iconyx array, but I get errors when
 writing beams

Analog audio sounds like its gating.

My Iconyx is slowly flashing the blue wink light.

My IC16R, IC24R, LC32R or IC Live Dual shows up as only a 
single IC8 or IC Live module.

Problems & Solutions  - FAQ’s



Possible Cause / Solution

This indicates your CobraNet components are not functioning 
properly and communications between your computer and the 	
loudspeakers on the network have been disrupted, a problem 
caused by your computer having gone into Sleep mode or by 	
some other Windows event. To correct, close RHAON (and, if run-
ning, CobraNet Discovery) and bring up the Windows Task 		
Manager (Ctrl-Alt-Delete).  Under the “Processes” tab , look for 
‘PACNDISCO.EXE’ and ‘PASSBRIDGE.EXE’ (Windows may shorten	
the names and add ‘~1’).  Select them and click “End Process”.  Pro-
ceed to re-open RHAON and/or CobraNet Discovery.

An alternate method of correcting the problem is to Restart the 
computer. To prevent this from reoccurring set your laptop’s 
Hibernation / Sleep settings to “Never”. 

Note that this CobraNet malfunction does not affect normal opera-
tion and your system will continue to operate normally until 		
you try to change some of the settings. 

SWITCH RELATED ISSUES

We recommend that your RHAON network be placed on a network 
separate to that of anything else.  If it is absolutely necessary to 
have them running through the same switch, it is recommended 
to use a managed switch and set up separate Virtual Local Area 
Networks (VLANs), grouping the ports you wish to use for RHAON 
in one VLAN and the ports for other devices in another.

1. Verify that the physical ports both your RHAON loudspeakers and 
your computer are connected to are all on the same VLAN. 

2. Verify that SNMP traffic (UDP ports 161 and 162) and CobraNet 
traffic (Ethernet protocol identifier 0x8819) are allowed on your 
VLAN.  Consult your switch documentation for how to configure 
VLANs.
 

Your switch may have Spanning Tree Protocol (STP) turned on.  
STP prevents accidental looping in your network topology, 	 but 
unfortunately needs to run an analysis on any new connection be-
fore it is deemed OK to be “on”.  If you want to avoid the delay and 
don’t need any services STP provides, turn off STP on your switch.  
Consult your switch documentation for instructions.

						    

Problem or Symptom

Some of my RHAON features are not working even though they 
worked previously. For example, when I try to change Presets 

the new Preset won’t load and I can change my EQ settings but 
can’t save them to the loudspeaker(s).

I placed my RHAON devices on the same network as other 
devices (venue PCs, lighting, etc.) and now neither RHAON nor 

the other devices are acting abnormally.

I have set up my VLANs but now I cannot connect to / scan for 
the RHAON loudspeakers on my network.

I have to wait 10-20s for my device to be “connected” and traf-
fic to begin when connecting my loudspeaker to the switch.

Problems & Solutions  - FAQ’s
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Possible Cause / Solution

NOTIFICATION ISSUES

A second network interface connected to a separate network is 
required for e-mail notifications or using remote desktop-type 
software to control the RHAON computer. You will need to contact 
the network administrator at the installation for details on connecting 
to their Simple Mail Transport Protocol (SMTP) server, also known 
simply as ‘the outgoing e-mail server.

What you enter in the “Name of Installation:” field is used as part of 
a spoofed “From:” field in the notification  e-mail.  Use of non US-
ASCII characters in an e-mail address is invalid. For example, use of 
Greek letters, symbols not on a US keyboard, or the ‘@’ symbol are 
not allowed.  For more information, please visit: http://en.wikipedia.
org/wiki /e-mail_address.

You need to install new 96 kHz DSP firmware (.Bin files) in your 
array. Open RHAON, Scan Network, right click on the array’s listing 
in the directory tree and select Update DSP Firmware from the pop 
up menu. When the Update DSP Firmware screen opens, select the 
newest 96 kHz .bin file and press Download. Refer to the array’s 
users manual for more detailed instructions on making this change.	
					   

Chances are that you installed the DSP Firmware .Bin files before 
installing the Microcontroller Firmware Hex files. The .Hex files 
need to be installed first. Re-installing the .Bin files should solve the 
problem. 

Chances are that you updated the firmware only in the Master Mod-
ule and did not update the slave modules.  When the firmware is 
being updated in a multi-module array like the IC24-R, the firmware 
must be individually updated in all modules. Refer to the IC-R users 
manual for details.

This sounds like a network problem. Use the Network Manager to 
check for network problems. Refer back to page 12 for troubleshoot-
ing tips. If possible, disconnect the array from it’s network connec-
tions and connect your laptop directly to the array. 

Problem or Symptom

How do I set up e-mail notifications.

While attempting to send e-mails I receive the following Error 
Message “The specified string is not in the form required for an 

e-mail address.”

I need to change the sample rate of my Array from 48 kHz to 
96 kHz. How do I do this?

I updated the firmware in the array I use for demos and now it 
doesn’t work. What  went wrong and how do I fix it?

I updated the firmware in my IC24-R array and now it is acting 
weird. What could have gone wrong?

I’m trying to update the firmware  in one of my Iconyx instal-
lations, but  I keep getting error messages while  trying to 

download the .Hex files.

Problems & Solutions  - FAQ’s



Problems & Solutions  - FAQ’s
AUDIO FAILURE PROBLEMS

Possible Cause / Solution

The first thing to do would be to check the network connec-
tion. 
Use RHAON to scan the network. If you can see the array on 
the network, drag it into the RHAON work space. If it Sync’s 
the network connection is OK.

1. If you can’t see it, check your network setup. Refer back to 
pages 11 & 12 for  detailed instructions.

2. Check the Array’s setup to make sure someone hasn’t 
changed it.

In RHAON double click on the Array’s Icon and open the Con-
nect tab.	 		
Is the power turned On? If not, turn it On.
Is the volume turned on all the way? If not, turn it up all the 
way.
Is the Mute On? If yes, turn it Off.

3. Select Pink Noise and click on Wink With Audio. Do you 
hear pink noise coming out of the array?
If the answer is yes; 
The array appears to be working and you are probably dealing 
with an intermittent (drop out) problem. Skip ahead to  Audio 
Drop Out. 

If the answer is no; 
Is the input meter showing activity? If it isn’t, either the ampli-
fier is dead or you aren’t able to communicate with it.

Is the output meter showing activity?
If the answer is no even though Mute is turned Off, the 
problem could be in any one of three modules. The Wink With 
Audio signal is generated within the DSP module and not 
within the amplifier, so the problem could be in either the DSP 
module, the Power Supply module or in the Amplifier.

Before calling Renkus-Heinz for assistance; 

4. Switch to the Supervisory mode in RHAON and start the 
Driver test tone. Do you hear the test tone?
If the answer is No, the amplifier is definitely dead. 

Problem or Symptom

One of my Iconyx / IC Live arrays has been working fine, but 
now it seems to be dead; it isn’t passing any audio. 

What can I do?
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Problems & Solutions  - FAQ’s
AUDIO FAILURE PROBLEMS (continued)

Possible Cause / Solution

If the answer is yes, the amplifier is OK and the problem is 
either in the Power Supply module or the DSP module. The 
Driver test tone originates in the amplifier module so if it works 
the amplifier module is OK. 

5. A likely suspect in older arrays is the SRC (Sample Rate 
Converter) in the DSP module. It is firmware controlled and 	
updating the microcontroller firmware may solve the problem. 

Check the Microcontroller version installed on the array (the 
version number is shown in the RHAON Supervisory window) 
and if it is earlier than version 2.43 update to the latest ver-
sion. 

Please call our technical support staff before updating the 
firmware. They will be glad to walk you through the update 
process.
	
If this solves the problem, great! If it doesn’t, you will need to 
return the unit to us for repair or replacement. Call our Cus-
tomer Service Manager and ask for a return authorization.

The likely suspect is the SRC (Sample Rate Converter). It 
malfunctioned and then restored itself while the power was 
turned Off. 

Intermittent failures like this are hard to predict; the same thing 
may happen the next time you use the array or it may never 
happen again. 

The SRC is firmware controlled and updating the microcon-
troller firmware may prevent the problem from reoccurring.. 

Check the Microcontroller version installed on the array (the 
version number is shown in the RHAON Supervisory window) 
and if it is earlier than version 2.43 update to the latest ver-
sion. 

Please call our technical support staff before updating the 
firmware. They will be glad to walk you through the update 
process.

Problem or Symptom

One of my arrays failed and I turned it Off while waiting for  a 
service man to show up. When he arrived it was working fine.

What is happening?
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